Targeted lipidomics data Skyline hands-on M.Wolk V1.3

Hands-on targeted lipidomics data:

Creation of a PRM transition list using LipidCreator and subsequent data analysis in Skyline

This short tutorial uses the PRM data acquired for Cholesteryl esters (CE) from a recently
published study!. The authors used a complex mass spectrometry (MS)-based strategy
combining untargeted and targeted workflows to generate a reference lipidome for human
white adipose tissue (WAT). The sample set included subcutaneous (SAT) and visceral (VAT)
WAT of lean and obese human. The mass spectrometry data were uploaded to MassIVE
(MSV000086729) and are freely accessible for download
https://massive.ucsd.edu/ProteoSAFe/dataset files.jsp?task=96087cf567c44906ae4cd83e41

106d98#%7B%22table sort history%22%3A%22main.collection asc%22%7D). In this tutorial,

the provided PRM data was acquired on a Q Exactive Plus Hybrid Quadrupole Orbitrap mass
spectrometer!. For further details the reader is referred to the publication the data origins
from.

While acquisition methods such as single or multiple reaction monitoring (SRM/MRM) will
record defined transitions (precursor to product ions), in PRM the pre-defined precursor ion is
fragmented and the total MS? spectrum recorded. For all these methods, it is necessary to
provide a list of precursors or transitions for which data should be acquired to the instrument.
For PRM, such list usually contains the precursor (formula or m/z) and corresponding retention
times (if performed in a scheduled manner).

In this tutorial, reported CE identifications from AdipoAtlas! are used to illustrate a targeted
workflow for PRM data to perform a relative quantification of CEs aiming to answer the
question how CE-abundances change between lean and obese patients. Therefore, this tutorial
will start with the generation of a transition list with the help of LipidCreator? (Version 1.2.1
within Skyline). Afterwards, the available PRM files will be used to relatively quantify CEs using

Skyline.

Within this tutorial you will explore:
* LipidCreator as a tool to rapidly generate PRM transition lists including isotopically
labeled standards.
* Analysis of lipidomics PRM data in Skyline.
* Relative quantification by using a global standard.
L Lange, M. et al. AdipoAtlas: A reference lipidome for human white adipose tissue. Cell Reports Medicine 2, 100407 (2021).

2Peng, B., Kopczynski, D., Pratt, B.S. et al. LipidCreator workbench to probe the lipidomic landscape. Nat Commun 11, 2057
(2020).


https://massive.ucsd.edu/ProteoSAFe/dataset_files.jsp?task=96087cf567c44906ae4cd83e41106d98#%7B%22table_sort_history%22%3A%22main.collection_asc%22%7D
https://massive.ucsd.edu/ProteoSAFe/dataset_files.jsp?task=96087cf567c44906ae4cd83e41106d98#%7B%22table_sort_history%22%3A%22main.collection_asc%22%7D
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Experimental Design

Lipids were extracted from approximately 50 mg of SAT and VAT

lean obese

‘ . WAT of lean and obese humans!. Organic phases were collected
and dried under vacuum. Lipid extracts, rich in Triglycerides
(TGs), were reconstituted in isopropanol and injected onto a
reversed phase column (Csp) and detected on a Q Exactive Plus
mass spectrometer. Prior to extraction, all samples were spiked
with SPLASH® LIPIDOMIX® Mass Spec Standard (Avanti
PolarLipids), containing deuterated lipid species. Of interest for

SAT VAT

this tutorial is the deuterated cholesteryl ester CE 18:2 (D7),

that will be used as global

standard to relatively quantify D, o

endogenous CE levels. B,

Identification of lipid species was achieved by a combination of software-assisted annotations
together with manual curation of acquired MS? spectra from DDA runs of pooled samples (Top
10). As in WAT, TGs were the dominating neutral lipid class, for the accurate quantification of
CEs, a PRM method was set-up, allowing a more sensitive detection of this group of lipids. The
tutorial starts after that manual identification of CEs within the lipid extracts was successfully
finished with several CEs identified as their ammoniated adducts ([M+NHa4]*). Next, these CEs
will be quantified by PRM. Therefore, in a first instance, a transition list for the targeted analysis
will be created, and afterwards acquired PRMs will be analyzed using Skyline. Here, for the
creation of the transition list, LipidCreator? will be used within Skyline, however, transition lists

can also be generated manually or with other software tools.

1 Lange, M. et al. AdipoAtlas: A reference lipidome for human white adipose tissue. Cell Reports Medicine 2, 100407 (2021).
2Peng, B., Kopczynski, D., Pratt, B.S. et al. LipidCreator workbench to probe the lipidomic landscape. Nat Commun 11, 2057
(2020).
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Getting Started

(1) Install LipidCreator from the Skyline ToolStore

: . ‘
Tools | Help i Install trom Toal Store ”

SRM Collider AverdGardeDIA Orgenizaten
L Poxsielpeing sl ‘ Lebriz-nstitut fuer Anahtische Wissenschaften - ISAS -e V
LipidCreator MPPReport futrors
| 'MS1Probe ' Dorminik Kopczynski. Nis Hoffmarn, Bng Peng
MSinspector u
l Tool Store... | | Mssan ‘ anguages
| Population Vastatior
Prego
External Tools... Protectypic Pepticé  Mare Information
Profter https-//qthub com/ifs tools Apidcreator
: . GuaSAR =
Immediate Window Scylne Gadgetfor  abs: S
| ?;’ﬁop Currently installed and fully updated (Verson: 1.2.1.787).
ot
. . TumoveR Descrpticn
Optl ons... ipidCreator provides support for targeted Ipidomics assay development based on liid bulding blocks and the smal molecule
AT support in Skylne. R provides Ipid fragmentation prediction. generation of lipid class specific target Iats, in-sfico spectral library
L} al rahin

generation and supports the latest community-approved lipid nomenciature

Tool Store... Reinstal Cose

(2) Un- ZIP the folder that contains the RAW files and save these 18 files in a folder of your

choice or download the corresponding RAW files from MassIVE.

EUnpala' OEx_PRM_CE_SAT lean_1

EUnpala
BB unpola

CE_VAT _lean_2

« PRM_CE_VAT_lean_3
CE_VAT_ob_1
BR unpola CE_VAT ob_2
El_lnpola QEx_PRM_CE_VAT_ob_3
CE_VAT ob_4
El_lnpola CE_VAT ob_5
[ ]¥] npolar_QEx PRM_CE VAT ob_6

(3) If you have been using Skyline prior to starting this tutorial, you | Stnes | Teoks Hep

[ Default
may want to reset Skyline to its default settings. To do so: i“fﬁcf"e"t'“
¢ On the Settings menu, click Default. , In’w
¢ You have the option to save your current settings here. i ’T*‘°‘E$t9'esset:f95"‘
For the tutorial, Skyline was set to “Default”. | oo

(4) Select the small molecule interface. Brv

% Proteomics interface

7 Molecule interface |

% Mixed interface
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Setting

up Skyline

(1)

(2)

Predction Lbrary Labels  Quartfication

Irtemal dandard ypes

Molecule settings Qe i
To change molecule settings, go to Settings and chose

Molecule settings and under “Labels” include heavy.

Transition settings

To change transition settings, go to Settings -> Transition ——

settings and change to the settings displayed in the screen shots:

In the Filter tab select as the Precursor adducts [M+NH4]*, as CEs are usually detected
as this type of adduct. As fragment adducts please include [M+] and [M+H]. lon types
only include fragments so can be set to “f”.

On the instruments tab, please change the values for min m/z (200) and max m/z (1500)
as well as the method match tolerance (0.005).

Under the Full Scan tab, select for MS1 filtering /sotope peaks included “none” and for
MS/MS filtering set acquisition method to “PRM” with Product mass analyzer being
“Orbitrap”. As Resolving power select “17,500 @ m/z 200" .

Optional: “Use high-selectivity extraction” can be used to extract a single-resolution

width around targeted m/z, lowering the interference in complex sample matrices.

| Transition Settings X -
| 9 Transition Settings X

it X
Predction Fkter Lbvary Instument Ful-Scan | lon Mobity kcion] T Pl B S o Ny Predction Fter Lbrary lnstument FulScan  lon Mobity Predction Fter Lbrary Instument Ful-Scan  lon Mobilty
Molecues
Precursor mass Product ion mass : Mo /e o MS] fitenng
Monoisotopic v Monoisotopic: v Precursor adducts. 200 o 1500 me Isotope peaks included:  Precursor mass analyzer
[N B O] O ot /e Nane
il Fragment adducts
Colision energy. Declustening patential Me], (Mo » Peaks: Resokution
None v None v | { Method match tolerance m/z
lon types: 0.005 m'z !
4
Optimization lbrary: Compensation voltage: t Isotope labeling ennchment:
| Fimware transton lmt Frmware nclusion lmt [
None v None v i
i MS/MS fitesng
[ Use optimization values when present Man time Max time. Acquistion method: Product mass analyzer:
mn min PRM v Orbtrap 2
] Triggered chromatogram acquistion Isolation scheme: Resolving power: At
17,500 200 mz
| [] Use high-selectiviy extraction
i Retention time fitering
| ocumor /s ewchision window @ Use only scans wehin [5 mites of MS/MS IDs
| | O Use only scans wehin minutes of predicted RT
| Ato-select all matching transtions. | | O Include all matching scans
Cancel oK e | == Cancel
| |
Transition settings used within this Tutorial. Values may change when data from a different instrument is used!
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Create a transition list with LipidCreator

The following CEs should be included in the transition list:

CE Retention time (min)
CE 18:1 (d7) 24.99
CE 18:1 24.99
CE 18:2 23.00
CE 20:3 23.29
CE 20:4 21.68
CE 22:4 23.71
CE 22:5 22.04
CE 22:6 20.96

(1) Transition for deuterated internal standard

* Open Lipid Creator (Tools = LipidCreator)

* You can select different Lipid classes from the tabs. Please select “Sterol Lipids”
as the lipid class of interest. To generate Cholesteryl esters, select the Type
“ester” and as molecule “SE 27:1” (Cholesterol will be annotated in Lipid creator
as SE 27:1).
Note: Cholesteryl esters created with LipidCreator will be named “SE 27:1/FA
X:Y”. In shorthand notation CEs are annotated as CE FA X:Y and thus CEs will be

referred to this nomenclature within the tutorial text.
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%, LipidCreator 1.2.1 - Opened with Skyline - X
File Options Help

Glycero-

Home Glycerolipids phospholipids Sphingolipids Sterol lipids Lipid Mediators

Step 1: Precursor selection Type

" Regular @ Ester Positive adducts

SE 283 I 2

SE 25:2 ¥ +NH4"

SE 30:2 7

O
)-K Fatty acyl chain hd No. DB No. Hydroxy
0] [18 [z [o

Step 22 MS/IMS selection Step 3: Assembly registration

Manage heavy isotopes | MS2 fragments | Filters Modify lipid | ‘ Add sterol lipids I

Sterol Lipids tab within LipidCreator.

* Onthe Filters tab change the settings in the following =

way : Precursor filters to “Compute no precursor | =™

¥ Compute no precursor transitions

" Compute only precursor transitions

transitions” and heavy labeled isotope filters tO | | compuewit precursortransitions

Heavy labeled isopote filter

“Compute with heavy labeled isotopes”. NOte: FOr | ¢ compuenchesy isselecisctopes

" Compute only heavy labeled isctopes

CEs we are only interested in the cholestene fragment | | Comoue sith heas lsbeledisctopes [
ion resulting from the loss of the fatty acid and this o ||

will be our only transition of interest.

Manage heavy isotopes x

Select mode
(% Addheavyisctope " Edit heavy isotopes

* Next, we have to define our isotopes via Manage

Lipid class Isotope suffix

. P . ez ] | ZE—

heavy isotopes. As lipid class select again “SE 27:1". | ...

As isotope suffix add “d7”, and as the building block, s i

so the location of deuterium atoms, select “fatty [ . . . 1
N 0 0 15N =l

acyl”. In the Elements table add Count (Isotopic) “7" |, . - = =
s 0 0 135 =l

for Hydrogen. And confirm by “Add Isotope”.

Add Isotope Close Window
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* In a next step, the deuterated CE 18:1 will be generated. Therefore, select for
Fatty acyl chain “18” and No DB “1” and “add sterol lipid”. Now your lipid list

contains your internal standard.

() LipidCreator 1.2.1 - Opened with Skyline
File Options Help

Glycero-

Home Glycerolipids phospholipids Sphingolipids Sterol lipids Lipid Mediators
~Step 1: Precursor selection Type
O Rgler  © Estr

(0]
o )k Fatty acyl chain | No.DB No. Hydroxy

18 [i [o

Step 2: MS/MS selection Step 3: Assembly registration

Manage heavy isotopes | MS2 fragments I Filters | ‘ Modify lipid I ; Add sterol Iipial
Lipid list
Category Building Block 1 | Building Block 2

Sterol lipid

| Building Block 3

| Building Block 4 Adducts | | Edt | Delete

Review Lipids

Sterol Lipids tab within LipidCreator with deuterated CE added to the Lipid List.

(2) Add unlabeled CEs to the transition list

* Change Filters for heavy labeled isotope filter to “Compute no heavy labeled
isotopes” and add the remaining CEs from the identification list. You can add
them one by one, or for instance for all CEs with 18 Carbons you can compute
all at the same time by setting No DB “1-2”. Once done with this step, you will

have a Lipid list that contains all CEs of interest.
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* Now you can Review Lipids. Under options select “Display precursors on species
level (only containing class specific fragment)”. This will be sufficient for CEs as

their MS2 only contains the cholestene ion at m/z 369.35. Click continue.

Lipid Precursor Review x

[3
"

! ¥ |sezmvaes [MeHa]1e laubd
"
"
[

FA20; DB: 3:4:0H: 0
FA‘18; DB: 1-2:0H: 0

FA18;D8: 1:0H:0

selectall | deselect ol Selected precursers: 7

[~Options
" Display precursors on subspecies level

¢ Display precursors on species level
{only containing class specihc fragments) o
" Dispiay precursors on spacies level = e

L) Lipid Transitions Review
[~ Options
lTI ’ I™ Edit mode ™ Only show unique transtions I~ Send spectral library to Skyline Check transition list |
e e [ S -l e ol S = S~ S s | S [
SE27:1/181 | C45H7802 [M+NH4]1+ 668.6340 +1 -FA 18:1(+HO)-... | C27H44 [M+H]1+ 369.3516 +1
SE271 SE 27:118:1(... |C45H7802 [M7H2+NH4]1+ |675.6779 +1 -FA18:1(+[2]H... |C27H44 [M+H]1+ 369.3516 +1
SE271 SE27.1/182 |CA5H7602  |[MsNH4J1+  |666.6184 +1 -FA 18:2(+HO-... | C27H44 [MsH]1+ 369.3516 +
SE27:1 SE27:1/203 | C47H7802 [M+NH4]1+ 692.6340 +1 -FA 20:3(+HO}-... | C27H44 [M+H]1+ 369.3516 +1
SE271 SE27.1/204 |CATH7602  |[M-NH41=  |630.6184 1 FA 20:4(+HO-... | C27H44 [M=H]1+ 369.3516 -1
SE27:1 SE27:1/224 | C49H8002 [M+NH4]1+ 718.6457 +1 -FA 22:4(+HO}-... | C27H44 [M+H]1+ 369.3516 +1
SE271 SE27:1/225 | CA9H7802 [M+NH4]1+ 716.6340 +1 -FA 22:5(+HO}-... | C27H44 [M+H]1+ 369.3516 +1
SE27:1 SE27:1/226 |C4SH7602 [M+NH4]1+ 7146184 +1 -FA 22:6(+HO}-... | C27H44 [M+HJ1+ 369.3516 +1

Number of transitions: 8

Store transition list Send to Skyline Store spectral library

Review Lipid list and select which information should be generated for the molecules on your list. Lipid
transitions review shows all transitions that were created based on selected parameters.

(3) Modify Transition list
*  You will now have a Transition list for CEs of interest. You can directly send the
transition list to skyline (Note: the list does not contain retention times yet) or

you can store the transition list as a xIsx-file. Please store the transition list.

MoleculeGra PrecursorName Precursorfor PrecursorAd PrecursorMz PrecursorChi ProductName ProductForm ProductAddu ProductMz  ProductChar, retention time
SE27:1 SE27:1/18:1 CASH7BO2 [MHNH4]1+ '668.6320 41 -FA 18:1{+HO)-Cholesterol{35) C27H44 [M4H]1+ 3693516 41 2499
SE271 SE 27-1 18:1{+[2]H7) (15TD) CASH7RO2 [M7H2+NHa]'6756778 41 -FA 18:1{+[2]H7){+HO}-Cholesteral [35) C27HA4 [M+H]1+ 3693516 41 2499
SE27:1 SE27:1/18:2 C45H7602 [M+NH4]1+ 6666184 +1 -FA 18:2(+HO)-Cholesterol(35) C27Ha44 [M+H]1+ 3603516 +1 23
SE27:1 SE27:1/20:3 C47H7802 [M+NH4]1+ 626340 H1 -FA 20:3(+HO)-Cholestercl(35) C27Ha44 [M+H]1+ 3603516 +1 23.29
SE27:1 SE27:1/20:4 C47H7602 [M+NH4]1+ 6006184 H1 -FA 20:4(+HO)-Cholestercl(35) C27Ha44 [M+H]1+ 3603516 +1 2168
SE27:1 SE27:1/22:4 CA9HBOO2 [MHNH4]1+ 718.6497 41 -FA 22:4{+HO)-Cholestercl(35) C27H44 [M+H]1+  369.3516 41 2371
SE27:1 SE27:1/22:5 C49H7BO2 [MHNH4]1+ 7166320 41 -FA 22:5(+HO)-Cholesterol(35) C27H44 [M+H]1+  369.3516 41 22.04
SE27:1 SE27:1/22:6 C49H7602 [WHNH4]1+ 7146184 41 -FA 22:6{+HO)-Cholesterol(35) C27H44 [M+H]1+  369.3516 41 2096

Screenshot from the transition list opend in Excel. Retention time for each lipid were added manually. The
labeled internal standard was marked as “ISTD”).
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* Open your transition list in Excel (or any other suitable program of your choice)
and modify it in the following way (highlighted in red): For the internal standard
please add “(ISTD)” to the precursor name and to all CEs add provided retention
times.

* Note: Alternatively, you can add retention times
directly in Skyline. Therefore, send the transition list
to skyline, right click on the molecule - Modify and

add the retention time. For a small number of

molecules this works fine, however, when you have
a data set with hundreds of lipids, adding in a separate _

document will be less time-consuming.

(4) Import Transition list and RAW data to Skyline p—
. T . . s |
* Forthe import of your transition list go to Edit than insert %=, .
® 4 Copy e C
«“ ot ] H X Deete Del
and “transition list”. Here you can simply copy and paste
your transition list from Excel to Skyline. Check that all T
> Transition List.. |
columns are assigned correctly and change if necessary.
Import Transition List: Identify Columns %
.
Precur PrecursorMz PrecursorCharge  ProductName ProductFomula Product Adduct ProductMz ProductCharge retention time
Molecule Li... v | Molecule Name v | Molecul v | Precursor Adductv | Precursorm/z v | Precursor Chargev | Product Name v | Product Formula v | Product Adduct v | Productm/z v | Product Charge v = Explict Retenti..~
SE271 SE 2711181 C45H7802 [MeNH4]1+ 668.6340 +1 FA18:1(«HO)}C... | C27TH44 [MeH]1+ 369.3516 +1 2499
SE 271 SE 27:118:1(+{2)... | CA5H7802 [M7H2+NH4]1+ 675.6779 +1 FAIE1(2HTN... C2THE4 [MeH]1+ 369.3516 +1 2499
SE271 SE27:1/182 C45H7602 [M+NH4]1+ 666.6184 +1 FA18:2(+HO)C... |C2TH44 [M+H]1+ 369.3516 +1 23
SE27:1 SE 27:1/20:3 C4TH7802 [M<NH4]1+ 692.6340 +1 FA20:)(+HO)C... | C2TH44 [MeH]1+ 369.3516 +1 2329
SE 271 SE 27:1/20:4 C4TH7602 [M+NH4]1+ 6506184 +1 FA 20:4{+HO)C C2TH&4 [MeH]1+ 369.3516 +1 2168
SE 271 SE 27:1/22:4 (C49H8002 [M+NH4]1+ 718 6457 +1 FA22:4(+HO}C... |C2THA4 M+H]1+ 369.3516 +1 2N
SE 271 SE 27:1/225 C49H7802 [M+NH41+ 716.6340 +1 FA 22:5(+HO)}C C27Ha4 [M+H]1+ 369.3516 +1 2204
SE271 SE27:1/226 C49H7602 [MeNH4]1+ 7146184 1 FA22:6(«HO)C... C2TH44 [MeH]1+ 369.3516 +1 20.96
O Peptides @ Molecules Show unused columns Check For Erors Cancel

Transition list view within Skyline. List is added by copy and paste from the excel table.
* Your transition list will now be displayed in the Target view within Skyline.

SE 27:1
a By SE27:1/181
a BY SE 27:118:1(+{2]H7) (ISTD)
@ ¥y SE27:1/18:2
@ By SE27:1/20:3
@ By SE27:1/20:4
v
e
-

Note: If the import of your transition list
worked, you can close LipidCreator. If you

have issues with csv/excel files, send the
By SE27:1/22:4
By SE27:1/225
j2o8 SE 27:1/22:6

transition list from LipidCreator directly

5)--E-F-5-5-E-m-m-ill

to Skyline and add retention times

manually as described under the Note in (3).
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* Next, import PRM RAW files provided with this tutorial. Go to File, Import and

select “Results”. Here select “Add single-injection replicates in files” and files to

import simultaneously “Many”. Click OK. Select all files provided with this

tutorial. You can remove the common prefix “Unpolar_QEx_PRM_CE” of the

files by selecting “Remove” as file names are relatively long and important

information will still be kept. Click OK and the data import will start.

File | Edit Refine View Settings Tools Help

& Start

O New CtrieN 1 x
& Open. Ctl+0

Open containing folder
[= Ctiles

Save As...
Share..
¢ Upload to Panorama...

Import » Results...

Export v

Peak Boundaries...

Exit

Assay Library...
Transition List...

Document..

Annotations..

Import Results

(@ Add singlenjection replicates in files

Optimizing Canc
None e

O Add multiinjection replicates in directories

(O Add one new replicate

(O Add files to an existing replicate

Import Results x

Files to import simultaneously

Many v

[ Show chromatograms during import
[ Retry after import failure

The files you have chosen have a common prefix. [
Would you like to remove some or all of this prefix to
shorten the names used in Skyline?

(O Do not remove
(® Remove

Common prefix:
|Unpolar_QEx_PRM_CE_

* Data import may take a few minutes and your Skyline window can look like this:

Note: You can transform/smooth data for better visualization of peaks.

Therefore, right click on the extracted ion chromatogram and select transform.

Here Savatzky-Golay Smoothing was used.

=

-

Data Validation
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* Onthe View menu, choose Peak Areas and click “Replicate Comparison” and “Molecule
Comparison”.

* On the View menu, choose Retention Times and click “Replicate Comparison” and
“Molecule Comparison”.

* Click and drag these views to dock them on your screen below the extracted ion
chromatogram.

* Inthe Targets view select the first Molecule “SE27:1/18:1”

.
[T [
¢ . I = .
210 20 %5
Rk 85 Poskies Wl Compn 3% Rton fves - Woede Compar wx SR — wx
o i - i e m
3 5
R 55
25 I
H xul
3 s i | A
H 2 Eo g 2
z H N g a- =
25 H 5 251
H ] g1 ;
3 o =1 3
2 =1l = 2
£ I 9
H 05 i L
i 2 B 4
05 "t
. ar
- = P = - M - @ = - = - - P = e
P i ¢ A Eof g B |E B % : ¥e
g Wotecul Rop
i

(1) Retention behavior of lipids

ke (10°5]

In the Retention Times “Molecule Comparison” window you can judge retention behavior
of lipids. Here, lipids were analyzed on a reversed phase column. The labeled CE 18:1 (d7)
and its endogenous non-labelled CE 18:1 should elute at very close retention times.
Moreover, for lipid species of the same lipid class having the same number of carbons, here
e.g., CE 22:4, CE 22:5, and CE 22:6 (green frame), the species with the highest number of
double bonds (CE 22:6) will elute first and the species with least double bond last (CE 22:4).
In the Retention Times “Replicate Comparison” you can check that retention time is similar

within all replicates. It will directly show you obvious outliers if present.
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Note: If you select in the targets list “SE 27:1” you can also inspect the extracted ion
chromatograms and “retention time- replicate comparison” for all the molecules contained
on you transition list. This will directly show you, if your endogenous CE 18:1 and its
deuterated standard elute at the same region of the chromatogram. For data sets with

many lipids you will also be able to identify lipids with potential isotopic overlap.

b Tres - bepcnaomprnon o
s
s
i
A
i eEEEEEEEEREEEEE P
S AR RN RRRRRIIN]
w0} : I EEEEEEEEEEEE
AN
EXS | &
/
. A/ fﬁba\
s B3 ®
[o———

(2) Check and adjust Peak integration
As you can see for the first Molecule SE27:1/18:1 the peak integration is not optimal (left).
Therefore, adjust Integrals to cover the whole peak (right). Check and adjust integration of

each Molecule in each file.

[— -Fa18:104H 369.3516[M+H]| [— Fats: 35) - 369.3516[M+H]|
6000 Explicit 6000 Explcit
25.0 25.0
- -
5000 5000
4000 4000
2 z
i 7
2 g
£ 3000 1 £ 3000 T
& &
2000 2000 1
1000 1000
0 \* 0
24 25 26 24 25 26
Retention Time Retention Time

(3) Normalization to Internal standard
In Lipidomics data sets, usually one to two internal standards are spiked per lipid class, thus
we can use the spiked deuterated CE standard to build a ratio of endogenous lipid to the

internal standard. Skyline will calculate this ratio for you by applying the following steps:

——
Replicates: SAT_lean_1 flspRcess) SATJesn |
= Se271
# @ By SE271181 7
et 21781
D @ A 663 6340(MeNH4] fotal ratio 2.8)
A Farg }Cholesterol(35) - 369 3516(MH 1] fatio 2.8)
' 16(M+H)1] fatio 1) 0
MH]1] fatio 1) oih g . 7 1) beavy) toalrato )
se21 @ Paste oA Tholesteri(35) - 369 3516{MeH1] frato 1
SEZ] X Delete "2 AL 665.5184044NH4] bt ot 1665
PR FA 18 2+HO)Cholesterdi(35) - 369 3516M+HY 1] fatic 16 65)
Pick Children ke a0 363
Add Precursor... 0 Precirsne. o xeri(35) 369 516MH1] o 263)
[ ¥ Set Standard Type » S o fr SEZZV204
[ SetStandard Type v ] None " ks o L 650 ST84M-NH4)fotl rto 28 95
Rl e T —— lodify... o L FA 20 4HO)Cholesterol35) - 169 ISTEMeHE1] )
Modfy. 7] Global Standard ify. 20:4(+HO}Cholesterol(35) - 369 3516{MeH] 1] fratio 28.95)
4 EditNote Surrogate Standard 4 EditNote
C —,Rm
Ratios To » = » s Lght
Replicates » . Replicates | Heavy | o
- [] Global standards B e AL TS 1 bt oo 199
— @ . FA226(+HO)Cholesterol(35) - 369 3516[M+H]1] fatio 1 99)




Targeted lipidomics data Skyline hands-on M.Wolk V1.3

e Define the deuterated CE as a “global standard”. Therefore, right click on the lipid
in the target view and select Set Standard Type “Global Standard”.

e To let Skyline calculate the ratio for you, next you do right click again on the lipid in
the target view and select Ratio to “Global Standard”.

e Inthe target view you will now see the ratios Skyline calculated for each lipid.

e In the “Peak Area-Replicate Comparison” window you will now see the Peak area
ratio to the global standard. This already gives you a first impression on your

guantitative data.

Peak Areas - Replicate Comparison 2 x

|— -FA 18:1(+*HO)-Cholesterol(35) - 369.3516[M+H] |

Peak Area Ratlo to Global Standards

SAT lean_3
SAT ob 1
SAT ob 2
SAT ob 3
SAT ob_4
SAT ob_&
SAT ob 6

VAT lean_1

YAT lean_2

VAT lean 3
WAT ob 1
VAT ob_2
WAT ob_ 3
VAT ob_4
VAT ob &
WAT ob_6

- o~
c c
o o
= =
- =
4 =
7] .}

Replicate

(4) Define groups for group comparison
As the experimental data was acquired from 4 different groups (VAT and SAT of lean

and obese), you can add these conditions into your document to compare the peak area
ratio of the four different groups. Therefore, go to Settings and select Document
Settings. In the Annotations window select “Add”. Define the annotation as “CE group”
and as type select “Value list”. As values please provide: VAT _lean, VAT_ob, SAT lean,

SAT _ob. These lists apply to “Replicates”. Click ok and select the newly created

* Document Grid: Replicates

1 Define Annotation X
Reports ~ 7~ ~ 4 4 |18 of 18 s Export.. Actions ~ | Find: E‘
Name
KCE grouos] Analyte
E J Replicate Sample Type Concantration CE groups
Edatle Colcuited | SATkean 1 | Unknown SAT Jean
L= 1 SAT lean 2 Unknown SAT Jean
| == v SAT lean 3 Unknown SAT_Jean
Values:
| raties SAT ob 1 Unknown SAT ob
VAT ob SAT ob 2 Unknown SAT_ob
SAT lean
SAT ob SAT ob 3 Unknown SAT_ob
| | SAT ob & Unknown SAT_ob
SAT b 5 Unknown SAT ob
Aopies to: SAT ob 6 Unknown SAT_ob
] Molecule Lists
L] Molecules VAT lean 1 Unknown VAT Jean
[] Precursors VAT lean 2 Unknown VAT lean
[] Transiions =
[ Replicates VAT lean 3 Unknown VAT Jean
Precursor Resuts
] Transton Rescts AT ob 1 Unknown VAT_ob
VAT ob 2 Unknown VAT_ob
| VAT ob 3 Unknown VAT ob
Po— VAT ob 4 Unknown VAT ob
- VAT ob 5 Unknown VAT_ob

|, |vATob & Unknown -
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annotation. Next, go to View and select document grid and chose from the drop-down
menu of Reports “Replicates”. Here you now need to add the above defined groups to
each replicate.

Addition of the groups now allows you to go the “Peak Areas- Replicate Comparison”
view and change it to the groups by right click group by “CE groups”. Skyline will now
show you peak area group averages normalized to your internal standard. This
representation indicates higher CE in the lean groups. Is this true for all CEs within this
data set? Note: Please keep in mind that this is only a relative quantification. And the
data is not normalized to the amount of internal standard and tissue weight or protein

amount. Therefore, conclusions must be drawn with caution!

[m— -2 22:6(+HO)-Cholesteral(35) - 369 351B[M+H] |

4
35 F
3 1

Peak Area Ratio to Global Standards
(o=

SAT lean SAT ob VAT lean VAT ob
CE groups

Data Export

The data is now ready to be exported. In order to export your data you first have to create
a document grid that contains all information you want to be exported. Go to View and
select document grid. Click on Reports and select the “Transitions” template. Next, click
again on Reports and “Customize Report”. We will modify this template in a way to contain
all information we need. Fist Change the name of the Report to “Transitions_CE”. Form the
screenshot you can see which values we want to export. You can find these from the list

by using the binoculars icon and type in the name.
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= Document Grid: Transitions
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T
To export your final data matrix select “Export” in the document grid window. You are done
with the Skyline Lipidomics PRM tutorial.
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Note: You can process your data now further and for instance multiply with the

concentration of the internal standard to obtain quantities and normalize these values

to tissue weight or protein content. This, however, is beyond the scope of this tutorial

that aimed to teach you how to generate transition list and analyze PRM data for lipids

within skyline.



